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1 Pitch Basics 

1.1 The Basic Process 

Pitch integrates video and interactive elements to create compelling, high quality presentations. 
The power of Pitch lies in the interactive elements.  On playback, your audience can browse 
documents, watch videos, and browse websites in full screen without leaving the presentation.  
 
The author prepares each scene in advance and has them queued up to appear as the 
presentation is recorded.  Post recording, scenes can be edited to remove any unwanted parts or 
pauses. 
  
The following diagram illustrates the process the author follows: 
 

 

 

 
The Prepare activities build the content of the presentation authors use as they record.  Scenes 
are organized similarly to slides, but unlike traditional presentation tools, Pitch allows authors to 
incorporate engaging visual resources including websites and documents in with images and text. 
For example, if you plan to reference an article or video clip from a major news provider, you can 
have it appear in a predetermined area of the presentation output while you discuss it.  Preparing a 
teleprompter script ensures that you convey information at the correct time, in the correct medium, 
with the correct words.  
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To expedite Prepare Mode activities, Pitch provides presentation Themes and Virtual Sets which 
are used to develop scenes.  A Pitch Theme provides a Scene background and a set of Scene 
Layouts representing common object positioning patterns for that theme.  A Pitch Virtual Set is a 
specialized Pitch Theme.  Virtual Sets provide backgrounds and Scene Layouts associated with 
formal presentations and broadcast studios, e.g., auditorium, late night talk show, etc. Themes, 
and Virtual Sets are explained in detail in section 4 of this Guide.  
 
The Pitch mode provides two ways to communicate and record your presentation - Record and 
Present.  
 

The Record option combines a camera view (of the presenter) with one or more scenes to 
communicate a complete story or create an educational resource.  Authors control starting 
and pausing the recording and the Scene List and teleprompter script are linked so they 
may choose to record parts or entire scenes multiple times.  

 
The Present option provides functionality similar to the Record mode, but with the 
presenter’s screen optimized for live presentations.  The audience sees the presenter’s 
screen either in real time or via recording without Pitch controls displayed.  

 
The Edit activities utilize an intuitive video editing interface (the clip tray) which allows you to 
insert, re-record, split, and delete portions of the video created during the Record process. Using 
Pitch, you create engaging presentations without advanced video editing experience. 
 
After your Pitch presentation is complete, it can be Shared with others as a simple .mp4 format file 
(no interactive elements) or as a fully interactive touchcast file (.tct) in the Fabric repository.  To 
view a .tct video, others must have Pitch installed. Alternatively, one can upload to TouchCast 
Fabric -- this provides a sharable link to the interactive video which can be given to viewers. In this 
scenario, viewers will not need to install any software -- the video is fully interactive in all modern 
browsers on all modern devices. 
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In addition to a main menu screen, where you create new projects or open existing project files, 
Pitch guides you through process using the following  ‘mode’ buttons at the top of the screens.  
 

 

 
 
Understanding three important Pitch features will help you present professionally: 

● The first feature is the scene list.  The scene list contains the presenter’s scene resources, 
queued up and ready to appear at the right point during recording.  The scene list is 
developed in the Prepare Mode and used during the Record and Present Modes. The 
scene list is explained in sections 4. 5, and 6 of this guide. 

● The second feature is the teleprompter script.  Each scene can have a written script 
developed and stored along with it.  The presenter uses this script to ensure key points are 
made by using pre-planned wording.  The teleprompter script is developed in the Prepare 
Mode and used during the Record and Present Modes. The teleprompter script is explained 
in sections 4, 5, and 6 of this guide. 

● The third feature is the clip tray.  Post recording, the clips are organized in a horizontal tray 
where each scene video segment and its interactive resources are identified with markers. 
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Pitch creates the clip tray content based on the recorded scenes.  All editing is performed 
from the clip tray during the Edit & Share Mode. The clip tray is explained in section 7 of 
this guide and tips on breaking presentations into multiple clips is presented in section 9 
Best Practice Tips. 

  
The end product of your creative work is a well-orchestrated presentation.  
 

1.2 Pitch Terminology 

 

.tcp file A file with the .tcp file extension is a TouchCast Project file.  As 
TouchCast Pitch and TouchCast Studio projects are being 
developed, they are saved in this proprietary TouchCast format. 
The .tcp file can not be opened and used by any other application 
outside TouchCast. 
 
In the iOS environment (iPad), the project data is maintained with 
the application and can not be accessed directly with a file explorer 
utility. See Studio Project Sharing for information on sharing or 
transferring a project file with another user/device. 

.tct file A file with the .tct file extension is a used by TouchCast Pitch and 
TouchCast Studio for output videos containing interactive 
resources. A .tct file must be viewed using a TouchCast product 
such as Studio, Pitch, or the TouchCast Fusion Video Player.  

.mp4 file A file with the MP4 file extension is an abbreviation for an MPEG-4 
Video file, which is a compressed file format that can contain not 
only video, but also audio and subtitles. MP4 files are commonly 
used for video sharing using platforms such as YouTube. 
TouchCast Studio and Pitch can create .mp4 format videos, but 
these videos will not contain interactive resources. 

Clip Tray The Pitch edit tool presents the individual clips of the recorded 
presentation in a horizontal list to facilitate finalizing each clip. 

Scene Layout Theme / Virtual Set Scene Layouts are conceptually like templates, 
providing background and common patterns of object positioning 
for Scene Themes / Virtual Sets.  

Scene List The column of scene thumbnails located on the left hand side of 
the Pitch screen. The Scene list can be expanded or contracted 
using a toggle button. 
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Pitch Project  A Pitch project (Pitch project file) contains all of the resources, 
scenes, recorded video, and teleprompter script for one complete 
presentation.  The output of a Pitch project is a touchcast .tcp file. 

Pitch Theme A Pitch Theme provides a Scene background and a set of Scene 
Layouts representing common object positioning patterns for that 
theme.  An exception is the Default Theme which does not provide 
a background and only a generic set of object layouts.  

Pitch Virtual Set A Pitch Virtual Set is a specialized Pitch Theme.  Virtual Sets 
provide backgrounds and Scene Layouts associated with formal 
presentations and broadcast studios, e.g., auditorium, late night 
talk show, etc.  

Teleprompter Script Script which goes along with each scene.  The teleprompter script 
can be visible to the presenter as the presentation is being 
recorded but it is not included in the recorded presentation.  

TouchCast Fabric TouchCast Fabric serves as both a storage repository and a 
sharing clearing house for touchcast videos. When users upload 
and share via Fabric, viewers do not need to install anything to 
enjoy an interactive touchcast video -- these work in all modern 
browsers on all modern devices including mobile. 
Fabric also serves as as the gateway for users logging into 
TouchCast products and other administrative functions.  

vApp TouchCast term for interactive components including websites and 
documents which can be incorporated into Pitch presentations. 

 
 

1.3 Keyboard Shortcuts 

Pitch provides keyboard shortcuts for many common actions.  Using keyboard shortcuts is 
optional, but Pitch users may find them a time saver.  
 

 
Project Controls 

Action Pitch MacOS 
Shortcut 

Save Project X + S 

New Project X + N 

 
Editing Text 

Action Pitch MacOS 
Shortcut 

Insert Text n/a 

Apply bold formatting X + B 
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Open Project X + O 

Export Scenes to PDF X + P 

Undo Action X + Z 

Redo Action X + Y  

Cut object or text X + X 

Copy object or text X + C 

Paste object or text X  + V 

New Scene X + SHIFT + N 

New Scene (in Prepare, Edit 
& Record) 

Down arrow 

Previous Scene (in Prepare, 
Edit & Record) 

Up arrow 

Send object back 1 position n/a 

Send object forward 1 
position 

n/a 

Send object to back n/a 

Send object to front n/a 

Select the next object TAB 

Select the previous object SHIFT + TAB 

Move object to the right Arrow keys or X + 
arrow key 

Move object to the left Arrow keys or X + 
arrow key 

Rotate the selected object 
clockwise 

OPTION + right 
arrow 

Rotate the selected object 
counterclockwise 

OPTION + left 
arrow 

Select all objects X + A 

 
 

Apply an underline X + U 

Apply italic formatting X + I 

Center paragraph X + E 

Justify a paragraph X + J  

Left align a paragraph X + L 

Right align a paragraph X + R 

Paste special X  + CONTROL 
+ V 

Increase the font size X + SHIFT + > 

Decrease the font size X + SHIFT + < 

 
 

Video Player Controls 

Action Pitch MacOS 
Shortcut 

Play or pause media SPACE 
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2 Installing and Operating Pitch 

2.1 Installing and Removing the Pitch App 

The TouchCast Pitch app for Mac OS X High Sierra is downloaded from TouchCast Fabric.  
 
Enterprise/Business accounts.  You will receive an email with a link to the following Fabric page 
after you create your TouchCast account and your administrator assigns you a subscription for 
Pitch (this depends on your organization type).  
 
Individual accounts are directed to the Fabric download where Pitch (or other TouchCast products 
included in your subscription) can be accessed/downloaded.  
  

 

  
Click the Download button located to the right of Pitch product option to proceed with the 
download.  A screen informing you of the download progress will display. 
  
After the Pitch app has downloaded, the installation process will begin and you will receive a 
message informing you when the Pitch app is ready to launch and use. 
  
Though we hope you won't want to, you can easily remove the Pitch app from your Mac by 
dragging the app icon from the Applications folder to the Trash (located at the end of the Dock), 
then choose Finder →  Empty Trash.  These steps will remove the app, but any data files you 
collected or created while using Pitch will remain where you put them, e.g., downloads (the app 
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file), documents, etc.  You will need move these to Trash and empty the trash to permanently 
remove them from your device.  
  

2.2 Initiating a Pitch Session 

2.2.1 Start Pitch Application 
To initiate a Pitch session, locate the TouchCast Pitch application in the Applications List or 
on the Dock tray if it has been ‘pinned’ to the Dock already (as shown below). 
 

 

 

2.2.2 Pitch Log in 
During your first use of Pitch or if you logged out after your last Pitch session you will need 
to log in to Pitch using your account ID and password as explained in section 2.2.2.2 
Logging In With a TouchCast Account.   
  

 
Page 13  



 

 

  
User Guide 

 

 

 
The steps which follow explain the Login process for new Pitch users and those who have 
not logged in using that device previously.  
 

 

 
● If you previously have established a TouchCast account (email address is used as 

the account identifier), enter that email address in the Email entry field and click the 
Login button. You can also login using your Google or Facebook login credentials. 
See more on this process below in section 2.2.2.2 
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● If you have not previously established a TouchCast account, click the Sign up link. 
See more on this process below in section 2.2.2.1 

 
● If you would like to view the TouchCast Terms of Use, click the Terms of use link 

located below the sign on fields. 
 

● If you would like to obtain general TouchCast support information, click the Support 
link located below the sign on fields. 

 
● If you would like to review the TouchCast Privacy Policy, click the Privacy policy 

link located below the sign on fields.  
  
 

2.2.2.1 Establishing a New TouchCast Account  
All TouchCast products share a common account management process and shared 
database.  Once you establish a TouchCast account to use the Pitch, you can use that 
Account to use other TouchCast products.  
 
To begin the process of creating a TouchCast account, click the Sign Up link.  
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Clicking the Sign up option displays the first screen of the process (shown below) where the 
user enters their email address and clicks the Sign Up button. 
 
If the user realizes that they already have an account, they can click the Click here to sign 
in link to return to the Login screen.  
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After the email address to be used for the new TouchCast account has been entered and 
the Sign up button clicked, a page for entering basic account credentials displays.  
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The information required to create a TouchCast account: 

● First  Name 
● Last Name 
● Password  - Passwords must be at least 8 characters long, contains at least one 

uppercase letter, a number, a symbol and doesn’t contain parts of the email 
address. TouchCast passwords are case sensitive.  Example: #Rusty123  

● Security Question (selected from list) and answer to the selected question 
● Checkbox to indicate agreement with the TouchCast Terms of Use 

 
Clicking the Sign up button, triggers validation of the email address and other required 
information. If the email address has previously been used to register in TouchCast, the 
user will be notified.  
 
The next step in the account creation process is for TouchCast to send the user an email 
(to the email account used to create the account).  
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The registering user enters the code from the email into the confirmation code entry field 
and clicks the Activate Account button. 
 
 

 
Page 20  



 

 

  
User Guide 

 

 

 
TouchCast will then activate the account and send the following screen which includes a 
link to the login screen.  
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From this point the new TouchCast account holder can enter their Account ID (email 
address) and the password they selected to begin working with Pitch.  
 
 

2.2.2.2 Logging In With a TouchCast Account 
 

All TouchCast products share a common account management process and shared 
database.  If you have a TouchCast account ID (your email address), enter it in the Email 
field and click the Login button.  The Password entry screen will display.  
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The Password entry screen will display where you enter the password associated with this 
TouchCast account.  
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Alternatively, users can select the Login with Google or Microsoft option and log in using 
their credentials. 
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If you have not previously accepted the TouchCast usage terms and conditions the 
following screen will display.  Please review these terms and check the box at the bottom of 
the screen indicating your acceptance of the terms and conditions before continuing.  If the 
terms and conditions change at some point in the future, the revised terms and conditions 
will display and require your acceptance. 
 

 

 
 

2.2.2.3 Forgotten Password - Password Reset 
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If you do not remember your password, click the I forgot my password link and the Reset 
Your Password screen (shown below) will display.  
  

 

 
Confirm the account ID (email address) and click the Continue button.  
 
Two events will happen.  First, the following screen is displayed explaining that you should 
have received an email containing a code you will need to enter in the screen to advance to 
the next step of the password reset process.  Second, for security proposes, you will 
receive an email providing you a code to enter in the Pitch screen. 
 
Screen requesting user to enter a code:  
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Email sent to users’ email account providing code: 
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After you enter the code sent in the email, your will be sent the following screen directing 
you to enter the answer to the security question provided during TouchCast account 
registration.  In this example, the question was What is your favorite movie quote.  
 

 

 
After you enter the answer exactly as entered during registration and click Continue, you 
will be able to select a new password.  
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Passwords must be at least 8 characters long, contains at least one uppercase letter, a 
number, a symbol and doesn’t contain parts of the email address. TouchCast passwords 
are case sensitive.  Example: #Rusty123  
 
After the Save Password button is clicked, a screen advising you that the password has 
been successfully changed will display. 
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The new password you selected should be used to sign in. 
 

 

2.2.2.4 TouchCast Terms of Service and End User Agreement 
 

Clicking the Terms of Use link displays a screen containing TouchCast’s Terms of Service 
and End User Agreement. After reviewing the Terms of Service and End User Agreement, 
the user can close the screen and return to the sign on screen. 
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2.2.2.5 TouchCast Support 
 

Clicking the Support link displays a screen containing TouchCast support information. 
After reviewing the Support information, the user can close the screen and return to the 
sign on screen. 
 

 

 
The TouchCast Help Center page can also be opened using the Help option of the main 
menu as shown below. 
 

 

 
 
 

2.2.2.6 TouchCast Privacy Policy 
 

 
Page 31  



 

 

  
User Guide 

 

Clicking the Privacy policy link displays a screen containing the TouchCast Privacy Policy. 
After reviewing the TouchCast Privacy Policy, the user can close the screen and return to 
the sign on screen. 
 

 

 
 

2.3 Signing Out and Logging Out of Pitch 
There are two ways to sign out of Pitch (close the application). 

2.3.1 Sign Out Using Menu Icon 
One way is to click the Pitch screen (to display the Pitch menu option to the right of the 
Apple icon located at the top of the screen).  Click the Pitch menu option, then the Quit 
Pitch button to continue signing out of Pitch. 
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2.3.2 Sign Out Using the Dock 
The other way to sign out is to right click the Pitch icon on the Dock (if used).  Click the Quit 
option to continue signing out of Pitch. 
 

 

 
 

2.3.3 Saving Project Work 
If a Pitch project is currently open and has not been saved, you will receive the following 
notification advising you to save the project before signing out of Pitch. 
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The popup for initially saving a Pitch project file (Save As) looks like the following: 
 

 

 
If the file name already exists in that location, the following warning message displays. 
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2.3.4 Logging Out of Pitch 

If you sign out (quit) Pitch as explained in section 2.3.3, you will remain logged in and will 
not be prompted to sign back if when you restart the application on that device.  If you 
desire to logout of Pitch (e.g., to allow another user to log in with their account credentials) 
you can do that by closing any open action windows (so the Preferences menu option 
becomes active) then click Pitch → Preferences button.  The logout screen displays.  If 
you sign out of Pitch after logging out, sign in will be required the next time Pitch is opened. 
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2.3.5 Displaying Pitch Version Information 
If you need to know the version of Pitch installed on the device, click the About Pitch 
option. The pop up window will display the version and build number. 
 

 

 
 

2.4 Pitch Introduction Panels 

Not applicable to this version of Pitch. 
 

2.5 Camera and Microphone Access 

Not applicable to this version of Pitch. 
 
 
  

 
Page 36  



 

 

  
User Guide 

 

3 Creating and Managing Pitch Projects 
3.1 General - Pitch Main Menu Screen 

After completing sign in, the Pitch Main Menu screen displays, providing the following options: 
● Create new - create a new Pitch project 
● Recent Projects - open a recent Pitch project (listed) 
● Open project - open an existing Pitch project located on your device or other location 

 

 

 
A rolling display of the currently-selected option (Themes, Virtual Sets) is displayed in the top 
portion of the Main Menu screen. Themes can be selected by clicking them from the display. 
 

3.2 General Information About Themes and Virtual Sets 

The relationships between Pitch (presentations), Pitch scenes and Themes, and Theme Layouts 
are important to understand. The two diagrams presented below should help. 

 
First, here is a repeat from the ‘Basics’ terminology presented in section 1 of this guide. 
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A Pitch Theme provides a Scene background and a set of Scene Layouts 
representing common object positioning patterns for that theme.  

A Pitch Virtual Set is a specialized Pitch Theme.  Virtual Sets provide 
backgrounds and Scene Layouts associated with formal presentations and 
broadcast studios, e.g., auditorium, meeting room, etc.  

A Pitch Smart Template is a specialized Pitch Theme.  The Smart Templates are 
specifically designed for Pitches used for routine project activities and contain 
scene layouts specific to the template purpose.  Note: Smart Templates are an 
organization option. 

 
This first diagram illustrates the relationships:  

 

 

 
...and here are the rules summarized.  
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It’s important to remember that Pitch Themes (and their Layouts) still allow you to customize 
the interactive components used to suit specific needs.  
 

3.3 Create a New Pitch Project 

To create a new Pitch project, select one of the Themes or Virtual Sets shown on the Pitch Main 
Menu screen.  The screen defaults to Theme options, but clicking the Virtual Sets button replaces 
the Theme options with Virtual Set options for you to select from. 

3.3.1 Theme 
Themes provide you with a selection of scene layout patterns applicable to common types 
of presentations.  Each Theme has its own set of scene layout selections.  In addition to 
object placement, theme scenes may also provide title banner selections.  Section 4.5 
presents additional information about Theme selection as the New Scene option is 
explained.  
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The available Themes are: 
 

Themes 
Atna 
Augusta 
Aurora 
Blanca 
Capital 
Darwin 

 
Grizzly 
Hubbard 
Hunter 
Jackson 
Morgan 
Shasta 

 

3.3.2 Virtual Sets 
Virtual Sets are specifically designed for Pitches focused on a presenter in front of an 
audience (live or virtual).  The presenter’s camera feed will be inserted into the set using 
green screen effects processing.  For example, if you plan to record a Pitch to a small 
group of investors, you may choose one of the meeting room Virtual Sets as the theme but 
for a comedy sketch, the Late Night Talk Show theme would be more appropriate. 
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The available Virtual Sets are: 
 

Virtual Sets 
Lecture 
Cubes 
Ivory 
Studio 
Birch 
Wood 
Newsroom 

 

3.3.3 Smart Templates 
Smart Templates are an organization-specific option.  If included in the menu, the 
templates help you create common presentations, e.g., project charter, status report, etc.  
 

3.3.4 Theme / Virtual Set Search 

Not currently implemented Pitch for Mac OS X.  
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3.4 Open a Recent Pitch Project 

The Recent Projects option lists the projects you have recently worked with. 
 

Pitch projects often take several sessions to complete and perfect.  Pitch project files (.tcp files) 
can be stored on your device or other locations you can access to Save/Retrieve. Opening your 
existing Pitch Project files will be a routine process for you and to make this easier, the Pitch Main 
Menu screen lists the last five project files you have worked with.  Click any of the listed projects 
and Pitch will place you in Prepare Mode with that project. 

 
 

3.5 Open an Existing Pitch Project 

The Open Project option is another way to open Pitch projects including projects you have not 
recently worked with.  Navigate to where the project file is stored as shown below.  

 

 

 
Click on the project file you wish to open and Pitch will place you in Prepare Mode with that project. 
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3.6 File Menu Options 
The File options are available after a project file is open and are used to create, retrieve, and save 
Pitch presentation project files. 

 

 

 

 
The File options are: 

● New 
● Open 
● Close 
● Save 
● Save As 

3.6.1 New 
The File → New action is used to create a new Pitch presentation project.  The File → New 
action does not create Scenes within the presentation.  This is done using the ‘New Scene’ 
options (explained in section 4.5).  

 
If a new project is about to be created and a project is already open (and has changes 
which have not been saved), Pitch will notify you and providing the option to save the 
previous project file.  

  

3.6.2 Open 
The File → Open option is used to select an existing Pitch project (.tcp file) located on the 
device or network drive and resume developing it. 

 
 

3.6.3 Save 
The File → Save option is used to save an open (and updated) Pitch presentation (.tcp file) 
which had previously been saved on the device or network drive using the same location 
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and filename.   The presentation remains open after the Save operation is completed for 
additional development. 

 

3.6.4 Save As 
The Save As option is used to initially save a new Pitch project file or to save an existing 
Pitch project using a different file name or location.  New project files are saved as .tcp (a 
TouchCast format which contains interactive features).  The presentation remains open 
after the Save As operation has completed for additional development.  Note that you will 
need to save the touchcast each time a change is made. 

 

3.7 Sharing Pitch Project Files (.tcp files)  

In addition to sharing completed touchcast videos with others, you probably will find yourself 
sharing project files (the .tcp files) Pitch creates and updates as you develop your project.  Using 
an existing project to develop a similar new project saves time and promotes consistency, 
especially on a larger client engagement.  Here a two strategies:.  
● If you stored the project file on your local device, you can upload it to Fabric (outside the Pitch 

app using Fabric upload), then send your team mate that link.  
● Save the in-progress project file to a shared storage location others can access when you 

initially create it.  Then, if you need to share it, all you need to do is send them that link. 
 
Be sure that the original project file is copied (or saved in Pitch) as a new file to avoid updating the 
original author’s project (unless that is the intent - to pass the project file to someone else to 
continue working on.)  
 
Note: Pitch Project files can be rather large so you should avoid trying to email files, instead send 
others the link. 
  
Sharing video files (.tct files) 
There are two ways to share the finalized touchcast videos you have developed using Pitch.  
● Upload the file to Fabric, then send others the link to the file   
● Save the completed video (exported to a .tct file) to a shared storage location which others 

can access, then send them a link to the file.  
 
Note: Video files can be rather large so you should avoid trying to email video files, instead send 
others the link. 
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4 Prepare Mode 

4.1 General - Prepare Mode Screen Layout 

The Prepare Mode activities build the content authors will use as they record the presentation. 
Scenes are organized similarly to slides, but unlike traditional presentation tools, Pitch allows 
authors to incorporate engaging visual resources including websites and documents in with images 
and text.  
 

 

 
The Prepare Mode screen (shown above) contains: 

● Mode selections 
● Scene List and associated Scene View 
● New Scene option 
● Teleprompter Script options 
● Settings controls 
● Insert controls 

 
Each of these is explained below. 
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4.2 Mode Selections 

The Mode Selections (Prepare, Pitch, Edit, Record) represent major phases of the Pitch  
development process.  
 

 

 
 

Mode  

Prepare Develop the scenes which will be presented/recorded.  

Pitch Provides options to Record or Present, the Present option allowing 
more of a ‘live’ format. 

Edit Opens the Edit & Share screen where your revise your recorded 
presentation clips.  Edit becomes active only when scenes have been 
recorded.  The Edit & Share screen includes the option to export or 
upload your Pitch presentation. 

 
You will find that progressing through the modes may not be ‘one directional’.  For example, after 
you record or even edit your scenes, you may realize how adding another scene would enhance 
your presentation.  No problem.  Return to Prepare mode and add that new scene, then record it. 
After it is recorded, you can edit it along with the other scenes in your presentation. 

 

4.3 Scene List 

The Scene List presents a thumbnail image of each scene you have added to the project along 
the left hand side of the Pitch screen.  The currently-selected scene will display in the Scene View 
area of the screen.  The sequence of scenes in the Scene List represents the order they will be 
available when the Pitch is recorded.  New scenes are added to the bottom of the Scene List but 
can be moved or duplicated using Scene List functions.  
 
Later, when you record or present your scenes you do not necessarily have to follow the sequence 
of the Scene List you developed in the Prepare activities, but you will find it easier to if you 
organize your scenes in the order you will record/present them. 
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4.3.1 Scene List Expand Control 
This section intentionally left blank.  Not currently implemented in Pitch for Mac OS X. 

  

4.3.2 Managing Scenes Within the Scene List 
Scenes can be duplicated or deleted from the Scene List by moving the mouse pointer over 
the scene thumbnail and using the right-click sequence.  A popup appears providing 
options to manage the selected scene. 
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New Scene - Insert a new scene to the bottom of the scene list.  This process is explained 
in section 4.5 New Scene Option. 
 
Cut/Copy/Paste - The selected scene can be moved, duplicated, or removed from the 
scene list using standard Cut, Copy, and Paste operations (duplicating Move, Duplicate, 
and Delete options).  

Duplicate Scene - Clicking the Duplicate option creates an exact duplicate of the scene at 
the end of the Scene List 

Delete Scene - Clicking the Delete option deletes the scene and the Scene List is 
reorganized.  Note: the last remaining scene of a project cannot be deleted.  The Delete 
option will be disabled. 

Select All - Clicking the Select All option selects all of the scenes in the scene list. An 
example use of this function would be to select all of the scenes, then right click one of the 
selected scenes and select Duplicate to duplicate  all of the scenes with one command. 
You can can also use this process to delete all the existing scenes and ‘start over’.  

 
The order of scenes in the Scene List can be changed by ‘dragging’ them to a different 
place in the Scene List (click, hold, and move with cursor) 

4.4 Scene View 

An expanded view of the scene currently selected from the Scene List will appear in this area. 
This where individual scenes are developed by adding: 

● File, Web, Text, and TC Stock objects 
● Drawing objects 
● Teleprompter script 

4.5 New Scene Option 

To illustrate this topic we have created a new Pitch project using the Architecture Theme.  The 
presentation initially contains one scene, a title layout. (this demonstrates one of the features of 
Themes and Theme Layouts). 

 
After the presentation title has been edited it's time to add additional scenes.  In the examples 
below a new scenes is added. 
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4.5.1 Adding a New Scene Selecting Layout 
The first method is to add a Scene by selecting one of the Scene Layouts associated with 
the Architecture Theme we selected to create the project.  To do that, click the New Scene 
button.  A selection of Scene Layouts displays.  
 

 

 
In this example the layout splitting the scene 50/50 vertically with the camera feed on the 
left and interactive objects on the right is selected.  
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A new Scene is added to the project (see bottom of the Scene List). Normally, you would 
select the interactive objects to place on that right hand side of the scene but that will be 
shown in a later section.  

 

 

 

 
Page 50  



 

 

  
User Guide 

 

Scene Layouts help you visualize where your camera view, vApps, and banners will appear 
on the scene.  You will get familiar with the different patterns of Scene Layouts as you work 
with Pitch, but here is a summary of common patterns and their terminology: 

 

 

 

4.6 Teleprompter Script 

The Pitch Teleprompter Script allows you to capture notes, script and other information associated 
with a scene so that it can be referred to when that scene of the presentation is being recorded. 
The Teleprompter Script (text) displays during recording activities and remains linked to the scene 
during editing. 
 
There are two ways to create and edit teleprompter script text.  

4.6.1 Enter Teleprompter Script Into Area Below Scene 
One way to enter and edit Teleprompter Script is to enter / revise it using the field located 
beneath the scene view as shown above.  Click on the teleprompter script field and begin 
entering text.  A best practice is to break script into shorter paragraphs to make it easier to 
follow as you present.  Also, Teleprompter Script should be written as if you were talking, 
not as a formal document.  This way it sounds natural to your audience.  
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This method is useful for revising the teleprompter script for a specific scene and when you 
want to see the scene contents in a larger format to determine what points to include in the 
script.  

 

4.6.2 Enter Teleprompter Script Into Special Window 
The other method to enter and edit Teleprompter Script is to click the Teleprompter button 
located above the scene viewing area.  
 
A window opens which lists all scenes defined for the presentations (in a scrollable list). 
The script for any scene can be entered or revised.  After all script revisions for the 
presentation have been made, click the Save button located at the bottom of the list. 

  

 
Page 52  



 

 

  
User Guide 

 

 

  
This method is useful for developing teleprompter script which needs to be coordinated 
between scenes.  You can see points made in other scenes’ scripts and use copy and 
paste function to move script text.  

4.6.3 Viewing Teleprompter Script During Recording 
During the Pitch mode, the teleprompter will display text associated with scenes as they are 
recorded. The script will appear below the scene so the presenter can maintain eye contact 
with the audience.  The teleprompter can be manually turned off using the Teleprompter 
toggle button. The teleprompter script appears as semi-transparent text because it is not 
displayed in the presentation (it is not recorded as a layer of the recorded presentation.)  

 
If the script is longer than what can display in a few lines, the text will scroll through the 
display field.  The speed at which the Teleprompter Script scrolls is controlled by the setting 
of the Scroll Speed control.  A scroll setting of 100% is an average reading speed.  
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4.7 Settings 

The Settings options control: 
● Audio settings 
● Camera settings 
● Object format settings 

 

 

 

4.7.1 Audio Settings 
The Audio options are used to control which device microphone is to be used to capture 
the voice of the presenter or other sounds and how the volume should be set during 
recording activities. 
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 The Audio menu option are organized as follows: 

● Select Microphone 
● Level  

4.7.1.1 Select Microphone 
The microphone built in (or otherwise connected) to the device which should be used to 
record is selected using this option.  For example, the device in this example has a built in 
microphone so only one option is available. 

 

 4.7.1.2 Level 
The Level Control setting is used to adjust the record volume from the microphone.  It can 
be adjusted using 10 setting stops.  The lowest setting mutes the audio, the highest setting 
makes the audio recording very loud.  You should test the gain setting prior to recording.  

 
  

 4.7.2 Camera Settings 
The Camera options are used to control which device camera is to be used to capture the 
presenter during recording and how it should appear in relation to other objects. 
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The Camera menu option are organized as follows: 

● Select Camera 
● Mirroring 
● Greenscreen  

4.7.2.1 Select Camera 
The camera built in (or otherwise connected) to the device which should be used to record 
(Pitch Mode) is selected using this option.  For example, the device in this example has 
only one camera. 

 

4.7.2.2 Mirroring 
When filming yourself facing the device's camera, the image is automatically reversed, 
meaning any text in the shot will be back to front.  
 

4.7.2.3 Green Screen 
Checkbox controlling whether the Green screen feature is enabled.  

● When set off, the green screen feature controls remain inactive and hidden.  
● When set on, the green screen feature controls become active and appear.  
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Color Keying (also known as chroma key, green screen or blue screen) is a special effect 
technique which allows a specific color to be removed from the camera view.  The 
remaining image (e.g., the subject) can then be superimposed over another color, image, or 
video. The color removed is usually the background behind the presenter (typically a flat, 
evenly lit green or blue screen like that used by the weather forecaster at your local news 
station). Select the color to remove, and select the background color, image, or video which 
will be used to substitute for the removed color. 
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In Pitch, the Green Screen settings are specific to each scene of the presentation to allow 
different green screen settings for studio versus outdoor scenes within the same 
presentation. 

 

4.7.2.4 Adjustments 
The Adjustment control present two options: 
 

● Auto - On systems with a fast enough graphics card, Pitch offers Auto Greenscreen 
where the author does not need a solid color background.  Pitch will detect the 
subject’s image and eliminate the background around it.   If auto is selected and the 
device’s graphics card does not support this function, the following warning 
message is displayed. 

 

 

 
 

Auto Green screen. Here are some tips for getting the best from the Automatic 
Green Screen tool: 
● Work in a well lit environment. 
● If you notice some of your background is not fully removed, move to an area 

with a mono color and flat background (e.g. white wall without pictures or 
posters). 
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● Manual - (default) You manually control the green screen settings. 
 

Manual Green screen. Here are some tips for getting the best from the Manual 
Green Screen tool: 
● Light your shooting environment. Ensure the green screen is evenly lit and 

avoid any shadows falling across it.  
● With yourself in place, use the Chroma Key Picker tool in Green Screen 

Settings to remove your background.. Use the Sensitivity and Smoothness 
controls to adjust the green screen’s appearance. 

 
 

4.7.2.5 Green Screen Sensitivity and Smoothness Controls 
 

The Sensitivity and Smoothness controls become active only when green screen is 
enabled.  They work in unison to optimize the green screen effect. 
 
Sensitivity 
The Sensitivity Control (a slider control) is used to set how sensitive the system should be 
to the color to be substituted with the new background image.  If the sensitivity is set too 
high, the background along with the main image (e.g., the presenter) will be replaced 
causing the shot to appear incorrectly.  It may take a little bit of trial and error to obtain the 
optimum setting for the specific camera, lighting and keying color.  

 
 
 Smoothness 

The Smoothness Control (a slider control) is used to set how granular the system should be 
between the color to be substituted with the new background image.  If the smoothness is 
set incorrectly, the main image (e.g., the presenter) may appear a bit ragged.  It may take a 
little bit of trial and error to obtain the optimum setting for the specific camera, lighting and 
keying color.  

 

 4.7.2.6 Picker 
The Chroma key control is used to select which color in the camera view should be 
eliminated.  It is often called the ‘keying color’ because it is the color the special effect 
(substitution) is keying on.  The current color displays in a small box on the upper right 
corner of the Chroma key button.  
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The color green is often used (and is the default used in Pitch) because skin tones, hair 
color, and clothing are generally not green, so it is safer to use that color as the key. 
Sometimes green is not a good keying color (think Saint Patrick’s Day outfits) so Pitch 
allows the author to select (pick) the color to key on. 

 
When the Chroma key Picker button is clicked, a floating pen icon displays in the canvas 
area.  Position the icon over the color to be used as the keying color and tap the mouse 
select button.  That color replaces the color previous used as the keying color.  

 
If the color options provided are not satisfactory, click the color selection box and a pallet 
will open allowing selection of a wider range of colors. 
 

 

 
 

 4.7.2.7 Degreen 
The Degreen function reduces remaining green in the subject so it will not interfere with 
chroma-key with a green background. The default setting is off.  
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4.7.3 Format Menu Options 
The Format menu options are used to set/change characteristics (format) of scene objects. 
The Format options are organized in three sub-options.  

4.7.3.1 Style 
The Style Format options control appearance characteristics of an object, e.g., the border 
around an image or video. 
 

 

 
 

4.7.3.2 Content 
The Content Format options control the source of media objects, e.g., the URL of a Web 
object.  
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4.7.3.3 Arrange 
The Arrange Format options control size and position of objects, e.g., where an image 
appears or the order of layered objects (backward, forward). 
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Two important concepts regarding Format Options:  

● The format options available for you to select at any time are dependent on the 
object selected on the scene.  

● Some short-cut commands produce the same results as using Format options (e.g., 
X + B   Apply bold formatting to a selected text object) 

 
 
In many cases, such as the Content option, the entire option (or specific settings) will be not 
appear or will be disabled if they do not apply to the object selected.  For example, if a text 
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object has been selected in a scene, the Format Content options will include text formatting 
options but the Content → URL option will not be available.  
 
To close the Format option window, click the Format button.  The Format Option window 
will close and the Scene view will return to its normal size.  

 
Format options are a bit complicated to illustrate with examples, but the good news is that 
as you work with Pitch, you will discover that as a rule, all you have to do is select an 
object, select the Format Menu Option, and Pitch will take care of providing you with the 
formatting options you can do with that object. 

 
The following is a summary of significant Format options along with a legend indicating 
where that option applies:  

4.7.3.4 URL 
Clicking the Content → URL button allows the URL of the selected media object to be 
changed.  

 

  

4.7.3.5 Hotspot 
This Format option is used to ‘hide’ an active interactive object which has been placed at a 
specific location of the screen.  The vApp appears to the presenter in a special tray below 
the scene view.  The default setting is ‘off’.  

 

  

4.7.3.6 Border 
Clicking the Style → Border dropdown controls the border around objects. The default 
setting is ‘No Border’’. 
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4.7.3.7 Opacity 
Clicking the Style → Opacity slider controls the transparency of objects. The default 
setting is ‘100%’ (no transparency). 

 

  
  

4.7.3.8 Move Forward 
Clicking Arrange → Forward brings the selected object one layer forward if multiple layers 
of objects are used on the scene.  

 

  
  

4.7.3.9 Move Backward 
Clicking Arrange → Backward sends the selected object one layer back if multiple layers 
of objects are used on the scene.  

 

  

4.7.3.10 Remove (Delete) 
Clicking the Delete key removes the selected object from the scene.  
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4.7.3.11 Lock / Unlock 
Clicking Arrange → Lock button prevent further changes to the object until it is unlocked. 
The default setting is ‘unlocked’.  

 

  

4.7.3.12 Text Color 
The Arrange → Text Color control is used to set the text color of the selected text object to 
a color displayed in the color palette. The default setting is blue. 

 

  

4.7.3.13 Text Background Color 
The Arrange → Background Color control is used to set the background color of the 
selected text object to a color displayed in the color palette.  The default setting is ‘none’. 

 

  
  

4.7.3.14 Text Font, Font Size, Bold, Justify 
The Arrange → Font, Font Size, Bold, and Justify settings apply/remove settings control 
the appearance of the selected text object. 
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4.7.3.15 Stroke Color 
The Arrange --> Stroke Color control is used to set the object color of selected drawing 
objects. 

 

  

4.7.3.16 Width 
The Arrange → Width option is used to select the outline width of selected drawing 
objects.  

 

  

4.7.3.17 Outline Color 
The Arrange → Outline Color control is used to set the outline color of selected drawing 
objects to one of the colors in the color palette.  The default setting is blue. 

 

 

4.7.3.18 Align 
The Arrange → Align control is used to set the alignment of the selected object on the 
scene background.  The options are:  Left, Center, Right, Top, Middle, Bottom. The align 
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operation can be repeated.  For example, you can select Left, then Top to place the object 
in the upper left of the scene.  

 

 

4.7.3.19 Set as Background 
The Arrange → Set as Background control is used to set the selected image as the scene 
background. 

 

 
 
 

4.8 Insert Objects 

The Insert options are used to place media and drawing objects onto your Pitch scenes.  The use 
of powerful elements will enhance your audience’s experience.  The objects are inserted on the 
scene currently selected (appearing in the scene view).   Inserted objects can subsequently be 
moved, resized and deleted using Format and cursor functions. 
 

 

 
The Insert options are organized as follows: 

● File – Used to insert a file (image, document, or video) on the scene 
● TC Stock - Used to insert TouchCast Stock images on the scene 
● Web – Used to insert a website on the scene 
● Text – Used to insert text to the scene 
● Draw – Used to add line, arrow, circle, and rectangle objects to the scene 
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Additionally, you can Cut, Copy, and Paste interactive objects from/to scenes using clipboard 
commands. The process begins by selecting an object already placed on a scene, then selecting 
the clipboard action (Cut or Copy) to be performed with the selected object. The next step is to 
select the scene to place the object and select the clipboard Paste option.  

4.8.1 Inserting File Objects 
File objects, including documents, videos, and images, can be inserted as objects in an 
existing presentation scene by selecting the file icon representing a file clicking it.  Many 
common types of graphic media (.pdf, .png, .jpeg, .jpg, and .mp4 files) can be inserted as 
file objects in a Pitch presentation scene. Unsupported file types can be added to Pitch by 
converting them to a PDF. 

 
A popup will prompt the author to select the file object to be inserted into the scene.  In the 
example below, an image file (.jpg format) is selected to be inserted into the blank (black) 
scene.  
 

 

 
Click the Open button located at the bottom on the file selection popup. 
 
Pitch adds the file (image) object to the selected scene as shown in the following example. 
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In this layout, the Empire State Building image was placed in the middle of the scene, then 
resized and moved to the right of the text.   Note the change to the Scene List.  
 

4.8.2 Inserting TC Stock Objects 
TouchCast Studio provides a collection of royalty free media (images and videos) you may 
insert as an object into an existing presentation scene by clicking the TC Stock icon.  
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When you click the TC Stock icon, the Insert Media screen opens providing you thumbnails 
of media plus a panel of filter criteria to narrow your search. 
 

● Search keyword 
● Videos or images 
● Categories 
● Orientations 
● Quality 

 
After completing your search criteria, click the Search button.  
 
Click the thumbnail of any object and it will be inserted in your scene as shown below.  In 
this example, a large stained glass image was selected. 
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Note the change to the scene in the scene list. 
  

4.8.3 Inserting Web Objects 
Web objects such as websites can be inserted as objects into an existing presentation 
scene by clicking the web icon.  
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A screen for selecting web objects opens.  Enter or paste the URL of the website to be 
added to the scene.  Pitch allows the site to be searched using browser features and will 
show any recently visited websites.  
 
An example of recently searched websites being displayed appears below.  You can select 
one of the recent searches to re-use that set of results. 
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You may also search for key terms using the address bar. To search for a keyword or 
phrase, simply type the query into the address bar and hit enter. The query will result in a 
google search. 
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In the example below, the phrase ‘architecture’ was entered. The Google search returned 
relevant sites. Select the website or navigate to a specific video, then click the OK button at 
the lower right corner of the pop up window. 
 

 

  
In the example above, the Wikipedia topic is inserted onto the scene. 
 
 
   

4.8.4 Inserting Text Objects 
Text objects, such as titles and labels, can be inserted as objects into an existing Pitch 
presentation scene by selecting the Text icon.  
 
The top text entry field was created by clicking a text icon on the layout. A text object box 
(containing the prompt phrase: Double-click to add text) is placed in the middle of the scene 
area.  The text can be entered there and moved as necessary.  
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4.8.5 Inserting Drawing Objects 
Drawing objects are used to add lines, arrows, circles, rectangles to scenes for emphasis, 
or to annotate a specific scene. The main drawing objects are: 

● Line 
● Arrow 
● Circle 
● Rectangle 
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Below is additional information on the use of drawing objects. 

Moving Drawing Objects 
Drawing objects can be moved while the presentation is being recorded, but cannot added 
or removed while recording.  Therefore, authors will want to place all drawing objects they 
plan to use while in the Prepare phase of a project. 

 
Deleting Drawing Objects 
Drawing objects can be deleted from scenes during Prepare by clicking the object and 
either pressing the Delete key on the device keyboard. 

  
Drawing Line Objects 
The Line drawing tool is used to add straight lines of any length or angle to the scene. 
Lines are positioned by clicking the line to select it and dragging the object to the desired 
location by moving the cursor. 
 
The length and direction of the line is controlled by clicking on one of the end point(s) and 
moving that point. 
 
Controlling line weight and color is explained in section 4.7.3 Format Menu option.  
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Drawing Arrow Objects 
The Arrow drawing tool is used to add arrows of any length, direction, or angle to the 
scene.  
 
Arrows are positioned by clicking the arrow to select it and dragging the object to the 
desired location by moving the cursor. 
 
The length and direction of the arrow is controlled by clicking on one of the end point(s) and 
moving that point. 
 
Controlling arrow weight and color is explained in section 4.7.3 Format Menu option. . 
  

  

Drawing Circle Objects 
The Circle drawing tool is used to add circles of any size to the scene. 
 
Circles are positioned by clicking the circle outline to select it and moving the cursor to 
reposition the object to the desired location using the cursor. 
 
The size of the circle (or shape) is controlled by clicking on one of the corner point(s) and 
moving the cursor. 
 
Controlling outline weight and color is explained in section 4.7.3 Format Menu option.  

  

Drawing Rectangle Objects 
The Rectangle drawing tool is used to add rectangles of any size to the scene. 
Rectangles are positioned by clicking the rectangle’s border outline to select it and moving 
the cursor to reposition the object to the desired location with the cursor. 
 
The size of the rectangle (or shape) is controlled by clicking on one of the corner points of 
the object box and moving that point.  
  
Controlling outline weight and color is explained in section 4.7.3 Format Menu option.  
 
  

Drawing Object Formatting 
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The location and size of Drawing Objects can be changed using drag and drop actions 
using the cursor. 
 
The Format menu option provides controls which allow the color and width of objects and 
object borders to be changed. 
 
In the example below, a rectangle object was placed on the scene. 
 

 
 
To demonstrate the use of Format options, the blue (default fill color) rectangle is modified  
by selecting the formatting command:  Content → Fill and selecting green as the fill color.  
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5 Pitch Mode - Record Option 
 
The Pitch Basics section of this guide explained that the Pitch Mode provides the author with two 
options for how their presentation will be presented and recorded, Record and Present.  This 
section covers the Record option, which is well suited for more ‘scripted’ videos, where scenes 
may require re-recording and additional material may be added while finalizing the video.  All 
inputs (camera view, microphone audio, scenes, scene objects, text, and drawings) come together, 
recorded so the presentation can be viewed by others. 
 
When you select to advance to Pitch Mode, a pop up window opens for you to select which Pitch 
Mode option you would like to follow.  Click the Record option.  
 

 

 
If you discover that you aren’t ready to record, or would prefer the Present option, click on the 
Prepare Mode button to return to preparation activities.  
 
Remember, all recorded clips, created using either option, are placed into the Clip Tray. 
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5.1 Scene List and Scene List Display Control 

The Scene List displays the scenes created during Prepare mode as thumbnails along the left 
hand side of the Pitch screen.  
 
The Scene List Display Control is used to display (expand) or hide (contract) the Scene List.  If 
the Scene List is already displayed, clicking on the control causes the Scene List to contract out of 
view.  If the Scene List is contracted, clicking on the control causes the Scene list to expand. 
 
Example of contracted Scene List: 
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5.2 Selected Scene 

What appears in this area is what is being recorded (or will be recorded).  
 

5.3 Intentionally Left Blank 

 

5.4 Teleprompter Control 

The Teleprompter Control allows the presenter to display the teleprompter script as scenes are 
recorded.  The default setting is On. 
 
The teleprompter script appears as semi-transparent text because it is not displayed in the 
presentation (it is not recorded as a layer of the recorded presentation.)  If the script is longer than 
what can display in a few lines, the text will scroll through the display field.  
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5.4.1 Teleprompter Scroll Speed  
If the script is longer than what can display in a few lines, the text will scroll through the 
display field.  The speed at which the Teleprompter Script scrolls is controlled by the setting 
of the Scroll Speed control.  A scroll setting of 100% is an average reading speed. The 
speed can be reduced by clicking the down arrow or by clicking the << or >> icons located 
at either side of the speed display. 

 
Clicking the << (minus) icon decreases the scroll speed 10%  
Clicking the >> (plus) icon increases the scroll speed 10% 

 

5.4.2 Teleprompter Font Size Control 
The font which the Teleprompter Script displays is controlled by the setting of the Font Size 
control.  The default font size is 18 point.  

 
Clicking the ‘-’ icon decreases the font 1 size  
Clicking the ‘+’ icon increases the font 1 size 

 

5.7 Draw Control 

The Draw control is used by the presenter to add illustrations to a scene using the cursor as their 
drawing tool.  These drawings can be placed on the scene while recording is active or can be 
placed when the recording is paused so that the illustrations will already be in place when 
recording is resumed. 
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There are seven Draw Control options available: 
 

5.7.1 Shape 

Select the shape of the object, (e.g., rectangle, circle, line, arrow) to be placed on the 
scene.  
 

5.7.2 Erasers 
 

Removes specific illustrations (lines) or all drawings from the scene.  Clicking on the eraser 
icon turns the cursor into an eraser which removes any drawing it passes over. Clicking the 
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arrow immediately below the tip of the eraser icon opens a window to select the option 
erase all drawings on the scene (just the currently selected scene).  

 
Clicking the main Draw Control icon again, reverts the cursor back to its normal function. 

 

5.7.3 Highlighter 

Draws a bold semi-transparent line. The color of the highlighter icon indicates the color 
which will be used for new illustrations. Clicking the arrow immediately below the tip of the 
highlighter icon opens a pallet where the illustration color can be selected from 6 color 
options and line size is selected using a slider control. 
 
After the color and size are selected, the cursor is used to draw on the scene. 

 
Clicking the main Draw Control icon again, reverts the cursor back to its normal function. 

 

5.7.4 Pen 
Draws a bolder (more dense) line than the Highlighter.  The color of the pen icon indicates 
the color which will be used for new illustrations.  Clicking the arrow immediately below the 
tip of the pen icon opens a pallet where the illustration color can be selected from 30 color 
options and line width is selected using a slider control. 
 
After the color and size are selected, the cursor is used to draw on the scene. 

 
Clicking the main Draw Control icon again, reverts the cursor back to its normal function. 

 
 

5.7.5 Laser Pointer 
Draws a simulated ‘laser pointer’ line with the cursor.  

 
Clicking the main Draw Control icon again, reverts the cursor back to its normal function. 

 
 

5.7.6 Clear All 
Clears all drawing object from the scene. 
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5.7.7 Undo / Redo 
Click the Undo and Redo options to remove/restore the last drawing object changes made 
to the scene. 

 

5.8 Run Time Clock 

The Run Time clock displays the length of time the scene has been recording in hh:mm:ss.  The 
time indicated is the time since recording began last and is not necessary elapsed recording time 
because the timer starts over each time the record is started or resumed. 

 
 

5.9 Finish Button 

The Finish Button is clicked when the author has completed recording all scenes (with possible 
multiple takes for scenes) and is ready to begin editing the presentation.  

 

 

 

5.10 Record/Pause Toggle 

The large red Record / Pause button controls when video is being recorded to the Pitch 
presentation.  When recording, the Pause button (three vertical lines icon) displays.  When paused, 
the Record button is displayed.  

5.10.1 Record Countdown 
When the Rec (record) control is selected, prior to capture starting, a Countdown Animation 
displays showing the countdown from 5 seconds (the default delay) to when zero is 
reached and the recording actually begins and the Recording Control panel is displayed. 
During the countdown, the Recording Controls panel is displayed, but all options on the 
Recording Controls panel are inactive.  During the countdown, the presenter can tap the 
Countdown Animation to stop the countdown (cancel starting to record) and return to the 
Screen Capture Setup Panel.  If the recording is cancelled and the presenter returns to 
Setup Panel, all selected settings will appear as they had been set. 
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5.11 Scene Advance 
The Scene Advance control is used to move (advance) through the scenes in the Scene List as 
they are recorded.   Clicking on the upper arrow (up arrow ^) returns to the last scene in the scene 
list.  Clicking on the lower arrow (next arrow v) advances to the next scene in the scene list.  The 
current scene number is displayed above the arrows. 

 
Note: The same function can be performed by selecting scenes from the scene list, but you may 
want to collapse the scene list making the Scene Advance the only option. 
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6 Pitch Mode - Presentation Option  
 
The Pitch Basics section of this guide explained that the Pitch Mode provides the author with two 
options for how their presentation will be presented and recorded, Record and Present.  This 
section covers the Present option, which is used to create presentations using a screen more 
suited to a live audience situation.   All inputs (camera view, microphone audio, scenes, scene 
objects, text, and drawings) come together so the presentation can be viewed by others, either live 
or recorded.  Scenes recorded in Pitch Mode are placed in the Edit Mode clip tray along with 
recordings made with Record Mode.  
 
When you select to advance to Pitch Mode, a pop up window opens for you to select which Pitch 
Mode option you would like to follow.  Click the Present option.  
 

 

 
If you discover that you aren’t ready to record, or would prefer the Record, click on the Prepare 
Mode button  
 
Remember, all recorded clips, created using either option, are placed into the Clip Tray. 
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In the Present option, the default is for scenes to display without controls showing.  This is done to 
support ‘‘live’ presentations where the audience is viewing your device screen. 
 
To provide the presenter basic controls, Present uses three special features: 
 

● Clicking the Escape key (esc) ends recording (if active) and returns the presenter to 
Prepare Mode 

● The Up and Down arrow keys can be used to advance through the scene list (even if the 
list is not currently displayed) 

● Moving the cursor temporarily opens an Option Window (explained in section 6.2) 
 
 

6.1 Selected Scene 

What appears in this area is what is being presented or recorded (or will be recorded).  
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6.2 Floating Option Window 

In Present Mode the default is for scenes to display without any Pitch controls showing.  This is 
done to support ‘live’ presentations where the audience is viewing your device screen.  To allow 
the presenter to perform necessary functions such as controlling the teleprompter, an Option 
Window appears temporarily when the cursor is moved. After a few moments, the window closes. 
 

 

 
 

6.3 Record Button 
The large red Record / Pause button controls when video is being recorded to the Pitch 
presentation.  When recording, the Pause button (three vertical lines icon) displays.  When paused, 
the Record button is displayed.  

6.3.1 Record Countdown 
When the Rec (record) control is selected, prior to capture starting, a Countdown Animation 
displays showing the countdown from 5 seconds (the default delay) to when zero is 
reached and the recording actually begins and the Recording Control panel is displayed. 
During the countdown, the Recording Controls panel is displayed, but all options on the 
Recording Controls panel are inactive.  During the countdown, the presenter can tap the 
Countdown Animation to stop the countdown (cancel starting to record) and return to the 
Screen Capture Setup Panel.  If the recording is cancelled and the presenter returns to 
Setup Panel, all selected settings will appear as they had been set. 

 

6.4 Teleprompter Control 
Clicking the Teleprompter option opens the teleprompter script window at the top of the Scene. 
The presenter and others viewing the device screen will see the teleprompter script but it is not 
recorded in the video clip.  Clicking the Teleprompter option when it is active closes the 
teleprompter script window.  
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Present Mode does not provide teleprompter controls available in Record Mode (e.g., script font 
size and scroll speed).  
 

 

 
 

6.5 Scene List Control 

Clicking the Scene List icon opens the Scene List on the left side of the Present Screen.  Clicking 
the Scene List icon when the Scene List is open hides the Scene List.  
 

 

 

6.6 Draw Control  

The Draw control is used by the presenter to add illustrations to a scene using the cursor as their 
drawing tool.  These drawings can be placed on the scene while recording is active or can be 
placed when the recording is paused so that the illustrations will already be in place when 
recording is resumed. 
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The Draw Control functions in Present Mode are identical to those used Record Mode.  Please 
refer to section 5.7 for information on Draw Controls. 
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7 Edit Mode 
 
The Edit Mode options are used to ‘finalize’ the presentation.  To activate the Edit Mode screen: 
 

● Click the Finish & Edit button located in the upper right corner of the Record Mode screen  
 

 

 
 

● Click the Edit Mode button near the upper left corner of the Prepare Mode screen 
Note: If you have recorded using Pitch mode Present option, click the Escape key to return 
to the Prepare Mode screen.  From there you can navigate to the Edit Mode screen. 

 
The Edit mode screen is displayed below and explained in this section. The edit tools are used to 
move through the recorded presentation and perform editing operations including: 

● Splitting clips into multiple clips to allow additional editing 
● Deleting entire clips or portions of clips 
● Retaking scenes 
● Adding additional recordings 

 
Note: If you select Edit Mode, but no clips have been recorded yet, you will receive the following 
message:  
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Click the Prepare Mode button to return to a screen where you can record scenes, (Record or 
Present) then later return to Edit Mode. 
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 7.1 Clip Playback Window 
The Clip Playback window displays the recorded frame at a specific location in the clip.  Playback 
tools are used to move through the recorded presentation and perform editing operations. 
 

 

 

7.2 Clip Playback Controls 

The Playback Controls are used to start/pause playback and move through the recorded clips. 

 

 

 

● Jump Clip (back) - Move back one complete clip 
● Step Frame (back) - Move back one frame of the current clip 
● Play / Pause Control - Play or pause the playback at the current position (playback bar) 
● Step Frame (forward) - Move forward one frame of the current clip 
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● Jump Clip (forward) - Move forward one complete clip 

 
  
 

7.3 Clip Playback Timer 

The Playback Timer displays both the current position in the presentation and the total length of 
the recorded presentation in mm:ss:tt format. 
 

 

7.4 Clip Action Options 

These options are used to: 
● Split the selected clip at the current position 
● Duplicate the selected clip 
● Delete the selected clip 

 

7.4.1 Clip Action Buttons 
One editing method is to use the Split Clip and Delete clip buttons as shown below. In this 
example, the selected clip is split into two clips at the point of the playback bar. 
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7.4.2 Right Click Action Options 
Another editing method is to select a clip, then right click.  A pop up of clip edit action 
opens. 
 

 

  
 
Summary of clip tray actions: 
 

● Splitting the selected clip produces two clips (replacing the original clip).  The playback bar 
serves as the split point. 
 

● Duplicating the selected clip creates an exact copy of that clip in the Clip Tray immediately 
after original clip. The new clip can be edited independently of the original clip. 
 

● Deleting the selected clip removes it from the presentation and the Clip Tray. 
 

● In the current release of Pitch, clips can not be moved within the Clip Tray. 
  

7.5 Clip Tray 

The Clip Tray provides a visual depiction of all clips comprising the presentation.  
The large vertical bar represents the current position within a clip (corresponds to what is 
displaying in the viewing area).  
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Below is additional explanation of symbols you will see on the Clip Tray: 
 
Playback Bar. The Playback Bar will advance during playback and it can be manually moved to a 
specific frame by clicking on it and moving the bar with the cursor. 
 
 

 

 
 
Current Clip. The currently-selected clip’s frame will be highlighted as shown below. 
 

 

 
 
Break Points. Breaking points between clips are represented with the following icon: 
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Transition.  Clicking the break point icon between clips displays transition options for how the clip 
will transition to the next clip.  

 

 

 

 
● No Transition (Default) 
● Cross Dissolve - Previous clip dissolves into the next one 
● Fade with Black - Previous clip fades to black and next 

one appears out of black  
● Fade with White - Previous clip fades to white and next 

one appears out of white  
● Wipe Right - Next clip wipes out previous one right to left 
● Push Top - Next clip wipes out previous one top to 

bottom 
● Push Bottom - Next clip wipes out previous one bottom 

to top 

 
 
Interactive elements (documents, websites) are represented with colored squares above the clip. 
 

 

  

7.6 Clip Tray Scale Control 

This slider control is used to adjust the size (visual representation) of each clip in the Clip Tray. 
This is used to compress the tray (if there are many clips) or expand the tray (to allow more precise 
splits). 
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7.7 Effects Options 

The Effects options menu contains three controls. 
 

 

 

7.7.1 Take 
The Take control is used to select which take of a scene should be used (if multiple takes 
were recorded for a scene).   In the example above, two takes are available of the current 
scene. 

7.7.2 Retake 
The Retake control is used to retake the current scene.  When this control is clicked, you 
are returned to the Pitch mode, where an additional take of the current scene can be 
recorded.  

7.7.3 Record More 
The Record More control is used to record additional scene.  When this control is clicked, 
you are returned to the Pitch mode, where an additional scene can be recorded.  

  

7.8 Playback Bar 

The Playback Bar indicates the frame position in the current clip playing.  That frame will display 
in the Playback Window. 
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7.9 Finalize - Save & Upload 

The Save & Upload option is clicked after all editing of the presentation has been completed and 
you are ready to share your TouchCast Pitch presentation files with others in your organization or 
with a wider, public audience.  To begin the process, click the Save & Upload button located at the 
upper right corner of the Pitch screen. 
 

 

 
  

7.9.1 Export Preparation 
 

When the Save & Upload button is clicked, Pitch prepares your project file for export.  The 
length of time required will depend on the number of scenes and the options used in your 
presentation.  During this time, the following screen is displayed:  
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8 Finalize - Upload / Export 
After the Pitch project is prepared for upload, the Save & Upload screen displays.  The screen 
presents options for how (the format) and where (locally or in TouchCast Fabric) the presentation 
should be saved and shared.  
 
Example with Fabric option not selected: 
 

 

 

8.1 Pitch Preview Frame 

Pitch automatically selects one frame from the presentation to be displayed in Fabric (if the Fabric 
Repository is used).  The user can not select the preview frame used. 

8.2 Pitch Title Name 

The Pitch Title field contents is used as the project name in TouchCast Fabric and as the filename 
if the file is exported to a local storage location. 
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8.3 Pitch Description 

The Pitch Description contents is used if the file is to be exported to TouchCast Fabric, but will 
not be used if the file is to be exported as a .tct file elsewhere (not to Fabric) or as a .mp4 file.  In 
these cases, the project description cannot be associated with the file.  Entering a Pitch 
Description is optional, but recommended so that others will understand the content in your 
presentation as they view a list of presentations.  

8.4 Fabric Upload Option 

Save to Fabric Cloud (checkbox) – Uploads the presentation to TouchCast Fabric where others in 
the enterprise department (or public if that is designated) can view the presentation.  Uploading a 
.tct file to Fabric allows you to share your fully interactive touchcast video internally, track analytics, 
and replace interactive media elements that you have added to it.  These features are described in 
the TouchCast Fabric documentation. 

 
This control indicates that TouchCast Fabric will be the sharing repository for the video. When it is 
set on, the upload begins and a progress window displays.  In the example below, the upload has 
completed. 
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By default, access to a new Pitch presentation through TouchCast Fabric is limited to the author. 
Clicking the Change button opens the Fabric screen where additional members from your 
organization can be granted access.  

8.4.1 Fabric Access Settings 

The Fabric Access Settings available are: 

● Link disabled for viewers  - You will be the only person able to find and view the 
presentation. Click the Save button to save your changes. 
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● Anyone with this link and specific external emails and email domains - Only you and 
persons listed will be able to find and view the presentation. Click the Save button to 
save your changes.  

 

 

When this access setting is selected, clicking in the dropdown opens a list of 
TouchCast users already registered in your Organization.  Select as many members 
as you like, then click the Save button to save your changes.  

 

● Anyone with this link and password - Only you and persons having the link and the 
system generated password will be able to find and view the presentation. When 
you select this sharing option, a field containing a TouchCast-generated password, 
specific to your file will display.  Give this password along with the link to persons 
you would like to share the video with.  Click the Save button to save your changes. 

● Anyone with this link - You and persons having the link will be able to find and view 
the presentation.  Give the link to persons you would like to share the video with.  

Below is an example of the email informing members of your organization of presentations 
you have specifically shared with them:  
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8.5 Link for Share 

After the sharing option has been selected, the screen will include an additional option for sharing 
the link to the presentation.  Click the Copy button to copy the link to the system clipboard so it can 
be pasted into communications to your teammates.  The Sharing URL provides others with all they 
need to view the video using the TouchCast Fusion Video Player.  The embedded code (HTML 
string)  can be copied and placed on other web pages to become a link to the video. 
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8.6 Export to TCT 

Export to .tct file – (recommended) Saves the presentation as a TouchCast format file. 
A Windows File Explorer window displays for navigating to the location (local device or network) 
where the file should be exported.  The export file name defaults to ‘New Project1’ (the 
presentation project name assigned on the export window) but can be changed as needed on the 
Windows Explorer Save screen prior to saving the file.  The filename extension defaults to ‘.tct’. 
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Exporting to a .tct file lets you share your fully interactive Pitch Presentations.  Viewers will need to 
have a TouchCast app installed on their device to play the touchcast video. 
 

8.7 Export to MP4 

Export to mp4 file – Saves the presentation as a standard mp4 file. 
A Windows File Explorer window displays for navigating to the location (local device or network) 
where the file should be exported.  The export file name defaults to ‘New Project1’ (the 
presentation project name assigned on the export window) but can be changed as needed on the 
Windows Explorer Save screen prior to saving the file.  The filename extension defaults to ‘.mp4’. 
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Exporting to a .mp4. will allow you to share your Pitch Presentation to websites such as YouTube 
and Twitter,  but unlike touchcast .tct files, viewers will not be able to interact with objects that you 
have incorporated into your presentation. 
 

8.8 Done With Upload or Export 

Click the Done button when you have completed uploading or exporting your video.  The 
Upload/Export screen will close and you will return to the Edit Mode screen. 
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9 Best Practice Tips 

9.1 Test Your Camera and Audio Setting 
Always check the Camera and Microphone settings before working with Pitch to develop 
presentations.  The default setting be fine for your session but it's always better to check them first.  
 
Use the Camera options to:  

● Select the camera to be used when you record 
● Setup green screen special effects if that is to be used 

Use the Audio options to: 
● Select the microphone to be used as you record 
● Set your microphone record volume (gain) 

 

9.2 Organize the Sequence of Your Scene List 
When you record or present your scenes you do not necessarily have to follow the sequence of the 
Scene List you developed in the Prepare activities, but you will find it easier if you organized your 
scenes in the order you will record/present them. 
 

9.3 Teleprompter Script 
Use of the Teleprompter Script is recommended. Even a simple outline will help you avoid 
‘rambling’ or omitting key information. 
 
Write Teleprompter Script as if you were talking, not as a formal document so it sounds natural to 
your audience. 
 
Speak naturally and vary the speed and volume of your voice. 
 
 

9.4 Drawing Objects - Prepare in Advance vs On the Fly 

Drawing objects, e.g., lines, arrows, circles, etc. can be added to scenes as you record or in 
advance, e.g., during scene preparation or when recording is paused.  The purpose of the drawing 
and your comfort using the drawing tools should be considered as you prepare your presentation. 
A good practice is to draw on the fly only when necessary and when you do, avoid overdoing it!  
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9.5 Break Presentations and Scenes Into Multiple Clips 
 
Each time you begin recording your Pitch presentation, Pitch starts a new clip.  You could begin 
recording and capture all of your scenes, then stop recording.  This will result in one very long clip. 
While this method could work, it makes editing and finalizing your presentation more difficult.  
 
A better approach is to start recording as you begin a scene and pause when you are done with 
that scene.  Using this method, you will have one clip for each scene (plus clips for scenes 
retakes).  The method makes editing your presentation easier.  
 
Yet another approach is to use Record Start / Pause operations to break sections within a scene 
into multiple clips.  This method provides additional flexibility as you edit and handle multiple takes.  
 

9.6 Save Your Project File Frequently  
Remember to save your project to a local (or network) storage location frequently (Pitch saves your 
project as a .tcp file which you can assign a name to as your save it).  
 

9.7 Use Shortcuts 

Many common Pitch operations can be performed using Shortcuts (key combinations).  Many 
users find this to be a time saver.   A table of available shortcuts is presented in section 1.3 of this 
guide.  
 

9.8 Uploading Files Using Fabric  
Project, presentation, and other files can also be uploaded directly to TouchCast Fabric using its 
Upload feature.  For instance, if you would like to share a .tcp (project file) with a co-worker, you 
can upload the file to Fabric where the co-worker can download it to his/her device and open it to 
begin working on the presentation.  Refer to the Fabric User Guide for information on file upload.  
 
 
End of Document 
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